
If you are not familiar with Windows, review this “Windows Tutorial” carefully.
You will learn how to:

• Use a mouse.

• Start Windows and explore window features.

• Use the taskbar, menus, Ribbon, dialog boxes, and other important 
aspects of Windows.

• Practice using Search and Help.

• End a computer session.

If you are familiar with Windows but need help navigating Windows files and 
folders, refer to the “File Management” tutorial. There you will find informa-
tion on how Windows stores information and how to use Windows Explorer, 
a tool for managing files and folders.
 Computers differ in the ways they can be configured. In most cases, when 
you turn on your computer, Windows loads automatically and the Windows 
log-on screen appears. When you see the Windows log-on screen, you need to 
log on and key a password. In order to log on, you need to know how to use 
the mouse.

Using the Mouse
A mouse is a pointing device and is your access to the computer screen, al-
lowing you to accomplish specific tasks. A mouse typically has two buttons—
one on the left (primary) and one on the right (secondary). A mouse might 
also have a center button or a wheel. To use a mouse, place your right index 
finger over the left mouse button. Place your thumb on the left side of the 

mouse. (Left-handed users can switch mouse button func-
tions by using the Control Panel.)

The mouse operates through a pointer, a screen object 
you use to point to objects on the computer screen. The 
normal shape for the mouse pointer is an arrow . To 
move the pointer arrow on the screen, you roll the mouse 
on any flat object, or on a mouse pad, which has a smooth 
surface designed for easy mouse rolling. Although you can 

use the keyboard with Windows, you will probably find yourself using the 
mouse most of the time.
 To use the mouse to point to an object on the computer screen:

1.  Turn on the computer (if it is not on already). Windows loads, and the 
log-on screen appears. The screen includes at least one log-on name and 
picture. If the computer has multiple users, you will see several names 
and pictures.

To log on, you need to move the mouse pointer to the log-on name that was 
assigned to you when your user account was created. The pointer on the 
computer screen mirrors the actions made by the mouse when you roll it. 
Place your hand over the mouse and roll it to the left. The pointer on the 
screen moves to the left.

WINDOWS TUTORIAL

NOTE

Laptop computers typically use a touch 
pad to select or move objects rather than 

a mouse.

i
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2.  Roll the mouse to the right, and watch the pointer on 
the screen move to the right.

3. Practice rolling the mouse in all directions.

4.  Roll your mouse to the edge of the pad, and then lift 
it up and place it back in the middle of the pad. When 
you feel that you can control the mouse position on 
the screen, roll the mouse to the name you have been 
assigned.

To log on, you will need to click the name to select it. Mouse 
clicks are covered in the next section; instructions for 
logging on to Windows 7 are covered in succeeding sections.

Clicks and Double-Clicks
Pointing is a mouse action used to position the mouse pointer at a specific 
screen location. The tip of the mouse pointer should be touching the object 
on the screen. You may see a ScreenTip when you point to an object. A 
ScreenTip identifies or describes the object or command.

NOTE

All examples in this tutorial refer 
specifically to Windows 7 using the Aero 

desktop feature. If you are using any 
other version of Windows, your screen 
might differ slightly from the images 

shown in this tutorial. However, because 
most basic features are common to all 

versions of Windows, this tutorial should 
be helpful to you no matter which version 

of Windows you use.

Figure 1
ScreenTip

Selected object

ScreenTip

Single-click actions with the mouse are used to select objects or commands. 
To practice a single click:

1.  Roll the mouse around on the mouse pad until the pointer on the screen 
is over the Recycle Bin icon. Remember that the direction in which you 
move the mouse on the pad represents the pointer’s movement on the 
screen.

2.  Press and release the left mouse button once. Pressing and releasing 
the mouse button is referred to as a click. The computer tells you that 
the action has been performed when the object you click is highlighted 
(typically, the color of the selected object changes) to indicate to you 
that it has been selected. In Windows, you often need to select an object 
before you can perform an action. For example, you usually need 
to select an object before you can copy it. Click a blank area of the 
computer screen to deselect the Recycle Bin icon.

Pressing and releasing the mouse button twice is referred to as a double-click. 
When you double-click an object on the screen, it is selected—the object is 
highlighted—and an action is performed. For example:
 When you double-click a folder, it is highlighted and opens to a window 
showing the items the folder contains.
 When you double-click a word in a text file, it is selected for a future ac-
tion. In a text file, the pointer becomes an I-beam for selecting text in the 
document.
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2.  Locate and point to the red button in the upper-right corner of the 
Recycle Bin window. A ScreenTip identifies the Close button.

3.  Click the Close button  one time to close the Recycle Bin window.

Figure 2
Recycle Bin window

Close button and 
ScreenTip

NOTE

Whenever you are told to “click” or 
“double-click” an object on the computer 
screen, use the left mouse button. If you 
have difficulty double-clicking an object, 
adjust the double-click speed by opening 

the Mouse Properties dialog box. 
(Control Panel—Hardware and Sound—

Mouse—Buttons tab)

Selecting and Highlighting
You can also select a larger object such as a picture or a block of text by using 
the mouse. Position the pointer on one side of the object, and hold down the 
left mouse button. Roll the mouse until the pointer reaches the other side of 
the object. Release the mouse button. The selected object is highlighted.

Drag and Drop—Moving an Object 
Using the Mouse
You can use the mouse to move an object on the screen to another screen lo-
cation. In this operation, you select an object and drag the mouse to move 
the selected object, such as an icon. The operation is known as drag and drop. 
Follow the steps listed below to drag and drop objects.

1.  Point to and double-click the Recycle Bin icon. The Recycle Bin window 
displays.
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1.  Using the mouse, move the pointer over the object you want to drag.

2.  Press the left mouse button but keep it pressed down. The selected 
object will be highlighted.

3.  With the left mouse button still depressed, roll the mouse until the 
pointer and selected object are placed at the desired new location.

4.  Release the mouse button to drop the object. The object is now 
positioned at the new location.

Using the Right Mouse Button
Pressing and quickly releasing the right mouse button is referred to as a right-
click. Although the right mouse button is used less frequently, using it can be 
a real time-saver. When you right-click an icon, a shortcut menu appears with 
a list of commands. The list of commands displayed varies for each icon or 
object.

Figure 3
Shortcut menu

Recycle Bin 
shortcut menu

As you progress in this tutorial, you will become familiar with the terms in 
Table 1, describing the actions you can take with a mouse.

TABLE 1 Mouse Terms

TERM DESCRIPTION

Point Roll the mouse until the tip of the pointer is touching the desired 
object on the computer screen.

Click Quickly press and release the left mouse button. Single-clicking 
selects objects.

Double-click Quickly press and release the left mouse button twice. Double-
clicking selects an object and performs an action such as opening 
a folder.

Drag Point to an object on-screen, hold down the left mouse button, 
and roll the mouse until the pointer is in position. Then release 
the mouse button (drag and drop).

Right-click Quickly press and release the right mouse button. A shortcut 
menu appears.

Select When working in Windows, you must first select an object in 
order to work with it. Many objects are selected with a single 
click. However, depending on the size and type of object to be 
selected, you may need to roll the mouse to include an entire 
area: Holding down the left mouse button, roll the mouse so that 
the pointer moves from one side of an object to another. Then 
release the mouse button.
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Pointer Shapes
As you perform actions on screen using the mouse, the mouse pointer 
changes its shape, depending on where it is located and what operation you 
are performing. Table 2 shows the most common types of mouse pointers.

TABLE 2 Frequently Used Mouse Pointers

SHAPE NAME DESCRIPTION

Pointer Used to point to objects.

I-Beam Used in keying text, inserting text, and selecting 
text.

Two-headed arrow Used to change the size of objects or windows.

Four-headed arrow Used to move objects.

Busy Indicates the computer is processing a command. 
While the busy or working in background pointer 
is displayed, it is best to wait rather than try to 
continue working. Note: Some of the working in 
background actions will not allow you to perform 
other procedures until processing is completed.

Working in 
background

Link Select Used to select a link in Windows’ Help or other 
programs.

Starting Windows: The Log-on Screen
The Windows 7 log-on screen allows several people to use the same computer 
at different times. Each person is assigned a user account that determines 
which files and folders can be accessed and personal preferences, such as 
your desktop background. Each person’s files are hidden from other users. 
However, users may share selected files using the Public folder. The log-on 
screen lists each user allocated to the computer by name.
 If the administrator has added your name to a given computer, the log-on 
screen will include your name. If the computers are not assigned to specific 
individuals, you may find a box for Guest or for a generic user. If your com-
puter is on a network, your instructor might need to provide you with special 
start-up instructions.
 After you have logged on to Windows 7, the desktop is the first screen you 
will see. It is your on-screen work area. All the elements you need to start 
working with Windows appear on the desktop.
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1.  If you have not already turned on the computer, do 
so now to begin the Windows 7 loading process. The 
Windows log-on screen appears.

2.  Click your name to select it. The Password box appears 
with an I-beam in position ready for you to key your 
password.

3.  Key your password.

4.  Click the arrow icon to the right of the box. If you have 
entered the password correctly, the Windows desktop 
appears. If you made an error, the Password box 
returns for you to key the correct password.

The Windows Desktop
The Windows Desktop includes the Start button, taskbar, and Notification 
area. You may also see icons on the desktop that represent folders, pro-
grams, or other objects. You can add and delete icons from the desktop as 
well as change the desktop background. The Start button is your entry into 
Windows 7 functions.

NOTE

On some computers, the log-on screen 
does not appear automatically. You might 

have to press the following keys, all at 
once, and then quickly release them: 

Ctrl + Alt + Delete .

Figure 4
Windows 7 Desktop

Desktop icons

Start button Windows taskbar
Notification area

Desktop background Gadget

Using the Start Menu
Click the Start button  on the Windows taskbar to open the Start menu. 
You can also press the Windows logo key on the keyboard or press Ctrl + Esc  to 
open the Start menu. Use the Start menu to launch programs, adjust com-
puter settings, search for files and folders, and turn off the computer. If this 
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is a computer assigned to you for log-on, your Start menu may contain items 
that differ from those of another user assigned to the same computer.

1.  To open and learn about the Start menu, first click the Start button on 
the Windows taskbar. The Start menu appears.

Figure 5
Start menu

Personal folder

Libraries

Separator line

Jump Lists icon

Start menu Search box

Click to open 
All Programs

Recently opened 
programs

Pin area

NOTE

The list of programs in your Start menu is 
dynamic. Installing new programs adds 

new items to the Start menu. Frequently 
used programs are placed in the left pane 

of the Start menu automatically.

 The left pane consists of three sections divided by separator lines. The top 
section, called the pin area, lists programs that are always available for you to 
open. These programs can include your Internet browser, e-mail program, 

your word processor, and so forth. You can remove pro-
grams you do not want listed, rearrange them, and add 
those you prefer.
 Below the separator line are shortcuts to programs 
you use most often, placed there automatically by Windows. 
You can remove programs you do not want listed, rearrange 
them, but not add any manually. The Recently opened pro-
grams list displays up to ten programs. Use the Jump Lists 

icon  for quick access to documents, files, or tasks. Simply click the Jump 
Lists icon , and a submenu appears to the right of the Start menu program. 
All Programs displays a list of programs on your computer and is used to 
launch programs not listed on the Start menu.

Below the left pane is the Search box, which is used to locate programs 
and files on your computer.
 The right pane is also divided into three sections. It is used to select fold-
ers, files, and commands and to change settings. Use the Shut down button 
at the bottom of the right pane to end the computer session.

2.  Close the Start menu by clicking a blank area of the desktop.
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Table 3 describes the typical components of the Start menu.

TABLE 3 Typical Components of the Start Menu

COMMAND USE

Left Pane
Pin area Lists programs that are always available. You can add and 

delete items to the pin area.

Below the First Separator Line

Programs Lists programs that you use most often. You can add to 
and rearrange the programs listed.

Below the Second Separator Line

All Programs Click to display a list of programs in alphabetical order 
and a list of folders. Click to open a program.

Search Use to search programs and folders. Key text and results 
appear.

Right Pane

Personal folder Opens the User folder.

Documents Opens the Documents library.

Pictures Opens the Pictures library.

Music Opens the Music library.

Games Opens the Games library.

Computer Opens a window where you can access disk drives and 
other hardware devices.

Network Opens the Network window where you can access 
computers and other devices on your network.

Connect To Displays networks and other connections that you can 
access.

Control Panel Opens the Control Panel.

Devices and Printers Opens a window where you can view devices installed on 
your computer.

Default Programs Opens the Default Programs window where you can 
define default programs and settings.

Help and Support Opens the Windows Help and Support window. Help 
offers instructions on how to perform tasks in the 
Windows environment.

Run Opens a program, folder, document, or Web site.

Shut down button Turns off the computer.

Using the All Programs Command
Most programs on your computer can be started from the All Programs com-
mand on the Start menu. This is the easiest way to open a program not listed 
directly on the Start menu.

hin19294_wt_OLC_i-xxviii.indd Page viii  7/30/10  12:37 AM user-f468hin19294_wt_OLC_i-xxviii.indd Page viii  7/30/10  12:37 AM user-f468 /Volumes/207/MHSF191/foe85387_disk1of1/0073385387/foe85387_pagefiles/Volumes/207/MHSF191/foe85387_disk1of1/0073385387/foe85387_pagefile



Windows Tutorial ix

1.  To open the All Programs menu, click the Start button . The Start 
menu appears.

2.  Click All Programs or the triangle to the left near the bottom of the left 
pane. The All Programs menu appears, listing the programs installed 
on your computer. Every computer has a different list of programs. 
Notice that some menu entries have an icon to the left of the name and 
others display a folder. Click a folder, and a list of programs stored in 
that folder appears. Point to a program to see a short description of the 
program. Click a program to open it.

Figure 6
All Programs

Program icons

Folder containing 
programs

Click arrow to 
return to opening 

Start menu

3.  Click Microsoft Office to open a list of programs in the Microsoft Office 
folder. Click Microsoft Word 2010. (See Figure 6.) In a few seconds, the 
Word program you selected loads and the Word window appears. Notice 
that a button for the Word program  appears on the taskbar. 
Press Alt + F4  to close the window.

Customizing the Start Menu
Both the Start menu and the desktop can be customized. You can add short-
cuts to the desktop if you prefer, and you can add and delete items from the 
Start menu. However, if your computer is used by others, the administrator 
may limit some customization functions.
 To add a program to the pin area of the Start menu:

1.  Point to the program you want to add to the pin list from the All 
Programs menu, and right-click it. A shortcut menu appears.

2.  Click Pin To Start Menu on the shortcut menu. The program will be 
added to the pin list in the left pane above the first separator line.
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To remove a program from the pin area of the Start menu:

1.  Point to the program you want to remove from the pin list, and right-
click. A shortcut menu appears.

2.  Click Unpin From Start Menu. The program will be removed from the pin list.

To change the order in which programs are listed in the pin area:

1.  Point to the program icon.

2.  Drag the icon to the desired position.

Using the Taskbar
The taskbar at the bottom of your screen is one of the most important features in 
Windows 7. The taskbar is divided into several segments, each dedicated to a dif-
ferent use. The taskbar displays a button for launching Internet Explorer, 
Windows Explorer, and Windows Media Player, and each of these buttons is 
pinned to the taskbar. Point to each button to display a ScreenTip. The taskbar 
shows programs that are running, and you can use the taskbar to switch be-
tween open programs and between open documents within a program. A thumb-
nail preview appears when you move the mouse over a button on the taskbar.

Figure 7
The desktop and the 

taskbar

Start button Windows 
Explorer

Internet Explorer Windows Media Player

Taskbar 
Notification Area

Taskbar Notification Area
The notification area is on the right side of the taskbar, where the current 
time is usually displayed. Along with displaying the time, tiny icons notify 
you as to the status of your browser connection, virus protection, and so 
forth. In the interest of removing clutter, the notification area hides most of 
the icons. Clicking the Show Hidden Icons button  “hides” or “unhides” the 
icons in the notification area. Point to an icon to see a ScreenTip. Click an 
icon to open the control or program.
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 The Taskbar Notification area also includes the Show Desktop button . 
The Show Desktop button appears at the right side of the taskbar. When you 
point to the Show Desktop button, the open program windows become trans-
parent, and the desktop displays. The Show Desktop button is a toggle but-
ton. Click the Show Desktop button one time to minimize all open 
programs. Click again to display the programs. The minimize command 
temporarily removes a window from the desktop.

Figure 8
Taskbar Notification 

area

Notification Area 
icons

Show Desktop 
button

Show Hidden Icons button

The Active Window
The window in which you are working is called the active window. The title bar 
for the active window is highlighted, and its taskbar button is also highlighted.

1.  Click the Start button and then click All Programs, Microsoft Office, 
Microsoft Word 2010 from the Start menu. The Word window displays.

2.  Click the Start button and then click All Programs, Microsoft Office, 
Microsoft Excel 2010 from the Start menu. The Excel window displays. 
Notice how the Excel window covers the Word window, indicating that 
the window containing Excel is now active. Notice, too, that a new 
button for Excel has been added to the taskbar .

Figure 9
Excel (the active 

window) covering 
the Word window

Word and Excel 
program buttons 
on the taskbar

Word window

Active window
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3.  Click the button on the taskbar for Word, the first program you opened. 
Word reappears in front of Excel. Notice the change in the appearance 
of the title bar for each program.

4.  Click the button on the taskbar for Excel. Notice that you switch back to 
Excel.

5.  Click the Word button on the taskbar to return to Word.

Changing the Size of the Taskbar
You can change the size of the taskbar using your mouse if your toolbar is 
crowded. It is usually not necessary, because of the multiple document style 
buttons and other hide/unhide arrows on the taskbar. Before you can change 
the size of the taskbar, it may be necessary for you to unlock it. To unlock the 
taskbar, right-click an open area of the taskbar and click Lock the Taskbar to 
remove the checkmark. A checkmark is a toggle command. Click to turn it 
off, and click a second time to turn it on.

1.  Move the pointer to the top edge of the taskbar until it changes from a 
pointer to a two-headed arrow . Using the two-headed arrow, you can 
change the size of the taskbar.

2.  With the pointer displayed as a two-headed arrow, hold down the left 
mouse button and move the arrow up until the taskbar enlarges upward.

3.  Move the pointer to the top edge of the taskbar once again until the two-
headed arrow displays. Hold down the left mouse button, and move the 
arrow down to the bottom of the screen. The taskbar is restored to its 
original size.

4.  Close the Word and Excel programs by clicking the Close button  for 
each program.

Parts of a Windows
Windows 7 displays programs and files in windows. When multiple windows 
display on the desktop, you will notice several common features in their ap-
pearance. Study the following windows and notice the similarities.

Figure 10
Notepad window

Menu bar

Title bar

Minimize button

Close button

Window border

Resize tab

Scroll bar

Maximize button
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Changing the Size of a Window
You can change the size of any window using either the 
mouse or the sizing buttons. Sizing buttons are the small 
buttons on the right side of the title bar that allow you to 
minimize or maximize the window (see Figures 10 and 11). 
This can be especially useful when you would like to display 
several open windows on your desktop and see them simul-
taneously.

1.  Open the Word and Excel programs if necessary. Click 
the Maximize button  on the Excel title bar if the 
Excel window does not fill the entire desktop.

Table 4 describes the sizing buttons.

TABLE 4 Sizing Buttons

BUTTON USE

Minimize 
Reduces the window to a button on the taskbar.

Maximize 
Enlarges the window to fill the entire desktop (appears 
only when a window is reduced).

Restore Down 
Returns the window to its previous size and desktop 
position (appears only when a window is maximized).

Figure 11
Microsoft Word 

window

Minimize button

Close button

Window 
border

Status bar

Scroll bars

Maximize button
Title bar

Ribbon

NOTE

Notice that the window occupies the 
entire desktop, and the Maximize button 
has changed to a Restore Down button. 

This type of function is known as a toggle: 
When a button representing one state 

(Maximize) is clicked, an action is 
performed, the button toggles to the 
alternate state, and the other button 
(Restore Down) appears. A number of 
actions in Windows operate this way.
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To practice changing the size of a window using the sizing buttons, follow 
these steps:

2.  Click the Restore Down button  on the Excel title 
bar. The Excel window reduces in size, and the Word 
window appears behind it. The Restore Down button 
has now changed to a Maximize button . Notice that 
the highlighted title bar of the Excel window indicates 
it is the active window.

3.  Click the Excel Minimize button . The Excel window 
disappears, and its button appears on the taskbar.

4.  Maximize the Word window by double-clicking the 
title bar. Double-click the title bar again to restore the 
window.

To practice resizing a window using the mouse, follow these 
steps:

5.  Point to the lower right corner of the window. The 
mouse pointer changes to a two-headed arrow . Drag 
the window border toward the center of the screen. 
Drag the window border down and to the right to 
enlarge the window.

NOTE

You can double-click a window title bar to 
maximize or restore the window or right-
click the program button on the taskbar 
and choose minimize, maximize, restore, 

or close. You can also use the Shake 
command to minimize every open window 
except the window you are “shaking.” To 
use the shake feature, drag the title bar 
back and forth with your mouse until the 
other windows are minimized. You can 

also use the Snap feature to maximize a 
window. Point to the window’s title bar 
and drag the window to the top of the 
screen. When the window’s outline fills 

the screen, release the mouse.

Figure 12
Sizing a window 
using the mouse

Drag to resize 
the window
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6.  Point to the top border of the window. Drag the border 
down to reduce the height of the window.

7.  Point to the right border of the window. Drag the 
border to the left to reduce the width of the window.

8.  Drag the window to the top of the screen. When the 
window outline expands to fill the screen, release the 
mouse.

Moving a Window
To move a window, point to the title bar and drag the 
window to a new location. You cannot move a maximized 
window.

1.  Click the Word Restore Down button if necessary, and 
point to the Word title bar.

2.  Drag the window to the lower left corner of the screen. 
Release the mouse.

Switch between Windows
When more than one program is open, you can switch between windows by 
using the sizing buttons or the taskbar. You can also press Alt + Tab  to switch 
to the previous window.

1.  If necessary, open Word and Excel, and maximize both windows.

2.  Minimize the Excel window. The Word window displays.

3.  Point to the Excel button  on the taskbar. A thumbnail preview of the 
Excel window displays. If you point to the thumbnail, the thumbnail 
enlarges so that you can preview the window. This feature is called Aero 
Peek.

NOTE

You can place the pointer on any part of 
the window border to change its size. To 
change both the height and width of the 
window, move the pointer to the bottom 
right corner of the window. The double-

headed arrow changes its orientation to a 
45-degree angle (see Figure 12). 

Dragging this arrow resizes a window 
vertically and horizontally. Dragging a 
window border (top, bottom, left, or 

right) changes the vertical or horizontal 
size of the window. Sometimes the 

borders of a window can move off the 
computer screen. If you are having trouble 
with one border of a window, try another 
border or drag the entire window onto 

the screen by using the title bar.

Figure 13
Taskbar buttons and 
thumbnail preview

Point to the thumbnail to see a 
full-size view of the window.

NOTE

To display thumbnail preview, your 
computer must support the Windows 

Aero feature.

4.  Click the Excel button to display the Excel window and 
to make it the active window.

5.  Press Alt + Tab  to switch to Word. You can switch to the 
previous window by pressing this shortcut, or you can 
continue to press Tab  to switch to an open window on 
the desktop.
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Display Two Program Windows 
Simultaneously
When multiple programs are open, you can arrange the windows using the 
following commands from the taskbar. You can also use the Snap feature to 
display two windows side by side on the desktop. To position two windows 
side by side, drag the title bar of one window to the left side of the screen 
until the window snaps to the left side. Release the mouse. Drag the second 
window to the right side of the screen until it snaps into place.

• Cascade windows

• Show windows stacked

• Show windows side-by-side

• Show the desktop

1.  Open the Start menu, and display Excel and Word if necessary.

2.  Right-click the taskbar, and click Show windows side by side. The 
windows display vertically.

3.  Right-click the taskbar, and click Cascade windows. The windows 
display on top of each other. The title bar for each window is visible.

4.  Click the Show Desktop button  located on the right side of 
the taskbar to see the desktop. The Word and Excel programs are 
minimized.

5.  Click the Show Desktop button  again to restore the programs.

6.  Right-click the taskbar, and click Show windows stacked. The windows 
are stacked vertically.

7.  Click the Close button on the title bars of each of the two program 
windows to close them and to show the desktop.

Using Menus
When you open a window you may see a row of descriptive names just below 
the title bar. A menu bar contains a list of options for working with programs 
and documents. These operations are either mouse or keyboard driven. They 
are called commands because they “command” the computer to perform 
functions needed to complete the task you, the user, initiate at the menu level.

Executing a Command from a Menu
You open a menu by clicking the menu name listed in the menu bar. When a 
menu is opened, a list of command options appears. To execute a particular 
command from an open menu, press the left mouse button and then drag 
down and release the mouse (click and drag). You can also click the com-
mand once the menu is open.
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Other Menu Symbols
Three dots following a menu option (an ellipsis . . .) indicate that a dialog box 
is displayed when that menu option is chosen. (Dialog boxes, discussed later, 
are small windows requesting and receiving input from a user.) Menus may 
also include a triangular arrow. Clicking the arrow displays a submenu with 
additional choices. If a menu command has a keyboard shortcut, the key or 
the combination of keys you press to activate the option appear on the right 
side of the menu. Commands that appear gray or dimmed are currently not 
available.

Figure 14
Notepad menu bar

Keyboard shortcuts for menu 
commands

Ellipsis following 
command

Menu commands

Menu bar

Perform the following steps for using menus:

 1. Open the Start menu, click All Programs, and click the Accessories folder. 
Click Notepad. The Notepad program opens, and a button appears on 
the Windows taskbar.

 2. Locate the menu bar, and click File. The File menu displays. Notice the 
keyboard shortcuts listed on the right side of the menu.

 3. Locate the Open command and notice that three dots follow the 
command. Click the Open command. The Open dialog box displays. 
Click Cancel to close the Open dialog box.

 4. Click File on the menu bar. Click Exit to close the Notepad window.

 5. Click the Windows Explorer button  on the taskbar. The Windows 
Explorer window displays.

 6. Locate the Organize command , and click the button. A menu of 
options appears below the command button.
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 7. Click the Layout command, and a submenu displays with additional 
options. Notice that several of the options appear with a checkmark. 
The checkmark option  indicates that the option is selected. Click the 
option again to turn off the checkmark.

 8. Locate the View button , and click the arrow beside the button. 
Drag the slider to Medium Icons and notice the change in the 
appearance of the icons in the Windows Explorer window.

 9. Press the Alt  key, and a traditional-looking menu bar appears. Press Alt  
again to hide the menu bar.

10. Press Alt + F4  to close the Windows Explorer window.

Displaying a Shortcut Menu
When the mouse pointer is on an object or an area of the Windows desktop 
and you right-click, a shortcut menu appears. A shortcut menu typically con-
tains commands that are useful in working with the object or area of the 
desktop to which you are currently pointing.

1.  Position the mouse pointer on a blank area of the desktop, and right-
click. A shortcut menu appears with commands that relate to the 
desktop, including view and sort options.

2.  Click outside the shortcut menu to close it.

3.  Right-click the time in the bottom right corner of the taskbar. A shortcut 
menu appears.

Figure 15
Windows Explorer 

window

Triangular arrow indicates a 
submenu will display

Menu commands

View button
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4.  Click Adjust date/time on the shortcut menu. The Date and Time dialog 
box appears. You can use this dialog box to adjust your computer’s date 
and time.

5.  Click Cancel.

6.  Right-click an icon on the desktop to display its shortcut menu, and 
then close the shortcut menu.

Using the Ribbon and Quick Access Toolbar
Microsoft Office 2010 applications include a Quick Access Toolbar and a 
Ribbon to access commands. The Quick Access Toolbar contains frequently 
used commands and is positioned above the Ribbon. The Ribbon consists of 
tabs, and each tab contains a group of related commands. The number of 
commands for each tab varies. A command can be one of several formats. 
The most popular formats include buttons and drop-down lists. The File tab 
displays a menu which lists the commands to create, open, save, and print a 
document.

1.  Open the Word program. The Quick Access Toolbar arrow should point 
to the Save button.

Figure 16
Time shortcut menu

Figure 17
Word window

File tab

Home tab

Quick Access Toolbar

Ribbon

Ribbon group
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2.  Point to and click the File tab. Notice the commands in the left pane.

3.  Click the Home tab, and locate the groups of commands on the Home 
tab (Clipboard, Font, Paragraph, Styles, and Editing).

4.  Locate the Quick Access Toolbar  above the Ribbon. Point 
to each button to identify it. Notice that a keyboard shortcut displays 
beside each button.

5.  Click the Page Layout tab. Notice the change in the number of groups 
and commands.

6.  Click the Home tab.

Using Dialog Boxes
Windows programs make frequent use of dialog boxes. A dialog box is a win-
dow that requests input from you related to a command you have chosen. A 
dialog box appears when a command listed in a menu is followed by an ellipsis 
(. . .). Many dialog boxes contain tabs which resemble file folder tabs. Click a 
tab to select it and to display its options. All Windows programs use a common 
dialog box structure. Table 5 lists several options you will see in dialog boxes.

TABLE 5 Dialog Box Options

Check boxes are square in shape. Click a box to turn 
on (check) or turn off (uncheck) the option. You can 
select as many check box options as needed.

A Combo or List box displays a list of choices. Use the 
scroll bar to display hidden choices. Use scroll arrows 
to move up or down in small increments. Drag the 
scroll box up or down to move quickly through the list 
of options. Click an item to select it, or key 
information in the text box.

Command buttons are rectangles with rounded 
corners, and they initiate an immediate action. If 
followed by an ellipsis (. . .) another dialog box opens.

A Drop-down list box is rectangular in shape and 
displays the current selection in the rectangle. Click 
the arrow at the right of the box for a list of available 
options.

Option buttons are round in shape. Only one option 
may be selected from within a group of options. If 
selected, the option contains a dot.

A Slider represents a range of values for a particular 
setting. Drag the slider left or right or click an arrow 
to change the current setting.

 (continues)
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TABLE 5 Dialog Box Options (continued)

Spin Box/Spinner includes two arrows. Click the up 
arrow to increase value. Click the down arrow to 
decrease value. Changes usually occur in an increment 
of one. You can also select the current value, and key 
a new number.

Text boxes are rectangular in shape and are used to 
enter data. An insertion point appears at the left side of 
the box, and text will be entered at the position of the 
insertion point. Press Delete  or Backspace  to delete or 
edit existing text. Double-click or drag over existing 
text to select it. Use the Home , End , or arrow keys to 
move the insertion point. 

Practice using dialog box options by completing the following instructions. 

1.  Open Word, if necessary, and click the Home tab.

2.  Locate the Font group, and notice the arrow in the lower right 
corner . Click the arrow (Font Dialog Box Launcher), and the 
Font dialog box displays.

Figure 18
Font dialog box

TABS
Click to display 

options.

HELP BUTTON
Click for help with dialog 

box options. CLOSE BUTTON
Click to close the dialog 

box.

SCROLL BAR
Drag scroll box or click 

scroll arrows.LIST BOX
Scroll to display options; 
click to select an option.

DROP-DOWN LIST
Click arrow to display 

options.

CHECK BOXES
Click to select or 

deselect.

COMMAND BUTTONS
Click Cancel to close without applying changes.

Click OK to accept changes in dialog box.
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3.  Click the Advanced tab, and notice the options in the dialog box. Click 
the Font tab.

4.  Locate the Font group. The Font group displays a list box with several 
fonts available for formatting a document. Drag the scroll box to the 
bottom to view a list of available fonts. Click to select the Tahoma font. 
You can also click the up or down arrows to locate a font.

5.  Locate the Font color group, and click the down arrow  to the right 
of the box. Locate the Standard Colors, and point to the colors to view 
a ScreenTip. Click Blue. Notice the change in the Font color drop-down 
list.

6.  Locate the Effects section. Click to select the check box for Small caps. A 
checkmark appears in the box.

7.  Locate the command buttons at the bottom of the dialog box. Click 
Cancel .

8.  Close the Word program by clicking the Close button .

Changing the Desktop
Use the Control Panel to change the way Windows looks and works. Because 
your computer in school is used by other students, you should be very careful 
when changing settings. Others might expect Windows to look and work the 
standard way. Having Windows look or work in a nonstandard way could 
easily confuse other users. (Table 6 describes how to access other settings.) 
To change the appearance of your computer, follow these steps. Talk to your 
instructor first, however, before changing any settings on your computer.

1.  Click the Start button on the taskbar.

2.  Click Control Panel on the right pane. The Control Panel window 
displays.

Figure 19
Control Panel 

window
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3.  Click the Appearance and Personalization link. The Appearance and 
Personalization window displays.

4.  Click Personalization and click the Window Color icon near the bottom 
of the window. Click a color from the color palette.

5.  Click Save Changes.

6.  Click the Desktop Background icon at the bottom of the Personalization 
window. Scroll through the list of pictures, and click to select a picture. 
Click Save Changes.

7.  Close the Personalization window.

TABLE 6 Settings Options

OPTION USE

Control Panel Displays the Control Panel window, which lets you change 
background color, add or remove programs, change the 
date and time, and change other settings for your 
hardware and software. The items listed below are 
accessed from the Control Panel.

Network and Internet Includes options to view the network status, connect to a 
network, set up file sharing, change Internet options, and 
so on.

Hardware and Sound Includes options to add a printer, change default settings 
for AutoPlay, sound, mouse settings, keyboard, and so on.

Appearance and 
Personalization

Includes options to change the desktop background, 
adjust screen resolution, customize the Start menu and 
icons on the taskbar, and change sidebar properties.

Using the Search Command
If you do not know where a file or folder is located, you can use the Search 
command on the Start menu to help you find and open it. You can also use 
the Search box in Windows Explorer to locate an item.

1.  Click the Start button on the taskbar. Notice the blinking insertion point 
in the Start Search box. You can start keying the name of a program, 
folder, or file immediately.

2.  Key calculator. The Start menu is replaced with a list of options 
including programs, Control Panel items, files, and documents 
containing the characters you keyed in the Search box.

3.  Click the Calculator option. The Calculator window displays.

4.  Close the Calculator window.

5.  Click the Windows Explorer button  on the taskbar. The Windows 
Explorer window displays.
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6.  Locate the Search box in the upper right corner of the Windows Explorer 
window.

7.  Click in the Search box, and key penguins. A picture of penguins 
appears in the window.

8.  Close the Windows Explorer window.

Using the Run Command
Windows allows you to start a program by using the Run command and key-
ing the program name. This command is often employed to run a “setup” or 
“install” program that installs a new program on your computer. It is best to 
use this command after you have become more familiar with Windows 7.

1.  Click the Start button on the taskbar.

2.  Click All Programs, and click the Accessories folder.

3.  Click Run.

Figure 20
Windows Explorer 

window

Search box in 
Windows Explorer

Figure 21
Run dialog box
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4.  If you know the name of a program you want to run, type the name in 
the Open text box. Often you will need to click Browse to open a drop-
down list of the disk drives, folders, and files available to you.

5.  Click Cancel to close the Run dialog box.

6. Open the Start menu, and locate the Start Search box.

7.  Key run, and notice that the Run program displays 
under Programs.

8.  Click the program name, and the Run dialog box 
displays.

9. Close the Run dialog box.

Deleting Files Using the Recycle Bin
The Recycle Bin is the trash can icon on your desktop. To delete a file, click 
the file icon, and drag it to the Recycle Bin.

1.  Double-click the Recycle Bin icon on the desktop. A window opens 
listing files you have deleted.

NOTE

Depending on your computer 
configuration, the Run command may 

appear on the Start menu.

NOTE

As a protection against deleting a file 
unintentionally, any file you have placed in 

the Recycle Bin can be undeleted and 
used again.

Figure 22
Recycle Bin window

Deleted files or 
objects

2.  To undelete a file, merely drag it out of the Recycle Bin 
window and place it on the desktop or right-click the 
file and click Restore.

3.  To empty the Recycle Bin and permanently delete files, 
click Empty the Recycle Bin in the Recycle Bin window, 
or right-click the Recycle Bin icon on the desktop. The 
shortcut menu appears. Click Empty Recycle Bin.
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Help and Support
Windows Help and Support is available to you as you work. Use the Help 
feature to answer questions, to provide instructions on how to do a proce-
dure, or to troubleshoot problems you are experiencing.

 1. Press the Windows logo key on the keyboard or click the Start button  
to display the Start menu.

 2. Locate the Help and Support feature on the right side of the Start menu, 
and click to open the Windows Help and Support window.

Figure 23
Windows Help and 
Support Window

Search Help text 
box

 3. Key gadget in the Search Help text box, and press Enter . A list of results 
for gadget appears in the Windows Help and Support window.
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 4. Point to the topic entitled “Desktop gadgets (overview).” Notice the 
shape of the mouse pointer . Click the topic, and the Windows Help 
and Support window displays information about gadgets. Read the 
information on Desktop gadgets.

 5. Click the Back button  located in the upper left corner. You return to 
the list of gadget topics. Notice that the “Desktop gadgets (overview)” 
topic is a different color. When you visit a topic, the color of the topic 
(link) changes.

 6. Click the topic entitled “Desktop gadgets: frequently asked questions.”

 7. Locate the Show all link in the upper right corner of the window. Click 
Show all to expand the text.

 8. Key the text keyboard shortcuts in the Search text box, and press Enter . 
Click the link Keyboard shortcuts, then click the link Windows logo key 
keyboard shortcuts. Review the list. (You may want to print this list for 
future reference.)

 9. Click the Browse Help button  at the top of the Windows Help and 
Support window. Click the All Help link. A list of subject headings 
displays. Click a heading to view related categories.

 10. Locate the Help button  on the taskbar. Right-click the button, and 
choose Close window.

Figure 24
Search results for 

gadget
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Exiting Windows
You should always exit any open programs and Windows before turning off 
the computer. This is the best way to be sure your work is saved. Windows 
also performs other “housekeeping” routines that ensure everything is ready 
for you when you next turn on your computer. Failure to shut down properly 
will often force Windows to perform time-consuming system checks the next 
time it is loaded. You can either log off the computer to make it available for 
another user, or shut it down entirely.

To Log Off
1.  Click the Start button on the taskbar.

2.  Click the arrow to the right of the Shut down button , and 
click Log Off.

To Shut Down
To exit Windows, use the Shut down command on the Start menu.
 This command has two important shut-down options which are accessed 
by clicking the arrow beside the Shut down button.

• Restart: Restarts the computer without shutting off the power. This is 
sometimes necessary when you add new software.

• Sleep: Puts the computer in a low-activity state. It appears to be turned 
off but will restart when the mouse is moved. Press the computer 
power button to resume work.

To shut down completely, click the Shut down button . Shut down 
closes all open programs and makes it safe to turn off the computer. Some 
computers will turn off the power automatically.

1.  Click the Start button on the taskbar.

2.  Click the Shut down button .

3.  Windows prompts you to save changes in any open documents. It then 
prepares the computer to be shut down.
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